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Preface

About this document

Who should read this guide?

The target audience for this guide are those who install or maintain FSM environments.

Every effort has been made to provide you with complete installation instructions. If information becomes
available after the creation of the installation media from which you accessed this guide, we will pro-
vide an updated version of the guide on the IBM/FileNet Customer Service and Support web site (http://
www.ibm.com/support). As a general rule, you should refer to the IBM web site to obtain the current version
of this guide.

This guide provides instructions for installing and/or upgrading IBM FileNet System Monitor, and identifies
the IBM/FileNet and 3rd Party products that are certified for the current release. Be aware that each release
of IBM FileNet System Monitor may have multiple Interims Fixes, or Fix Packs available for installation, each
with potentially different dependencies and installation requirements. Therefore, before you attempt to install
or upgrade IBM FileNet System Monitor, review the list of releases and their associated dependencies on
the IBM Support web site (http://www.ibm.com/support).

Before you start

Users of the guide should have knowledge about Unix and/or Microsoft Windows® operating system, web
servers, database systems and middleware platforms. The configuration of managed systems (clients)
requires advanced knowledge of all IBM ECM systems that should be monitored.

If you lack the requisite skill sets it is strongly recommended to have IBM Lab Services or a certified ValueNet
Partner install this product.

Where you find this guide

You can find this documentation on the FSM installation media in the following folder:

UNIX: <Mount point>/INSTALL/docs

Windows: <Drive letter>:\INSTALL\docs

http://www.ibm.com/support
http://www.ibm.com/support
http://www.ibm.com/support
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Feedback on documentation

Send your comments by e-mail to comments@us.ibm.com. Be sure to include the name of the product,
the version number of the product, and the name and part number of the book (if applicable). If you are
commenting on specific text, include the location of the text (for example, a chapter and section title, a table
number, a page number, or a help topic title).

mailto:comments@us.ibm.com
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Working with the Task Execution Manager

Starting the Task Execution Manager (CalaTEMa)

The Task Execution Manager needs a Java 1.4 runtime environment to be installed. On Microsoft Windows,
Java Web Start must also be installed. A JRE 1.4 including Java Web Start for Windows is available on the
Download page on the FSM web interface.

CalaTEMa is started via the FSM web interface. Start your browser and enter http://ServerName in its
address line (replace ServerName with the ip address or hostname of your FSM server).

Log in to the console and choose the Tools link in the frame on the left.

When the Tools page is displayed, choose the appropriate Task Execution Manager link.

Launch Task Execution Manager

There are two different start methods. If Java Web Start is installed (this is mandatory on Microsoft Windows),
choose the Java Web Start link. If the server detects an installed Java Web Start on the client, this is the
only link which is shown.

On Unix systems without Java Web Start, the .sh file can be downloaded and started. It uses the OpenJNLP
to start the application. The link to the shell script only appears, if Java Web Start is not installed.
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The CalaTEMa main screen

Before the Task Execution Manager starts, a login window for the cala_rex server is shown:

Login

Log in with a user that has the appropriate permission to execute tasks. The CalaTEMa window opens.

The upper part of the Task Execution Manager window shows the list of products that are available for the
user.

The Tasks combobox shows the administrative tasks for the selected product. The panel titled Task Specific
Settings changes if the task selection changes and shows the parameters for the currently selected task.
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Main window

The File menu

The Exit entry exits the Task Execution Manager.

The Tools menu

The View cala_rex clients ... entry shows all clients that are currently connected to the cala_rex server to
which you are logged in.

The Show environment ... entry shows the environment settings of a selected cala_rex client if a process
is executed on that client.

The Login ... entry allows you to login as another user without exiting the Task Execution Manager.
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The Add custom task ... entry allows you to create custom tasks for execution with CalaTEMa. See detailed
description below.

The Edit custom task ... entry allows you to edit tasks created by the Add custom task ... menu entry..

The Remove custom task ... entry allows you to remove tasks created by the Add custom task ... menu entry..

The Help menu

The Help entry shows global help for the Task Execution Manager.

The About entry shows version information about the Task Execution Manager.

The Show command line call button

This button displays a script with the command line call for the selected task including the given parameters.
The script can be saved to a file and can be executed manually.

NOTE The displayed script is intended to run on the cala_rex server. To run it on a client,
save the script and adjust the setting of the CENIT_ROOT variable to match the
setting on the client where the command line call must be started.

The Run task button

This button starts the currently selected task. The Task Execution Manager checks if all required fields are
filled in. If the task requires confirmation, a dialog is displayed.

The About this task button

This button shows specific help for the selected task. In this help window, you can find a short description
of the task as well as a description of all parameters.
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Creating custom tasks

The Add new task dialog

If you have the appropriate permission, you can create custom tasks.

Selecting the menu entry  Tools Add custom task ...  opens this window:

Add custom 

Product
Read-only. All custom tasks will be added to the product Custom.
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Task
Required. Specify the name of the task. The text you enter here will be shown in the Task listbox
in the CalaTEMa main window.

Command
Required. Enter the name of the command that must be executed. The command must be located
on the server where the task is executed later.

Confirm task execution
Optional. If you mark this checkbox, a confirmation window will be shown each time the new task
is started.

Arguments
Optional. Use the Add button to add new arguments. Use the Edit button to edit the selected
argument. Use the Remove button to remove the selected argument.

The Add and Edit buttons open the Add argument dialog which is described below.

Environment
Optional. Use the Add button to add new environment settings. Use the Edit button to edit the
selected environment setting. Use the Remove button to remove the selected environment setting.

The Add and Edit buttons open the Add setting dialog which is described below.

Help
Optional. Enter a help text for the new task. The help text is shown if the About this task button
in the CalaTEMa main window is pressed.

The Add argument dialog

In this dialog, you can define a command line argument for the task.



Working with the Task Execution Manager
Creating custom tasks

11

FSM Task Guide Addon Tasks (SC19-3112-00)

Add argument dialog

Name
Required. Enter the name of the field. The text you enter here will be used as label in the CalaTEMa
main window.

Field has constant value
Optional. Mark this checkbox if no entry field is needed for this argument. The label of the Name
field changes to Value because the value you enter in the textfield will always be passed to the task.

Field is required
Optional. Mark this checkbox if the argument is mandatory. The task cannot be started if the field
is left empty.

Skip field if empty
Optional. Mark this checkbox if the argument need not be passed to the task if it is left empty. If you
do not check this option, an empty field will be passed for this parameter if the field is left empty.

The Add setting dialog

In this dialog, you can define environment settings for the task.

Add setting dialog
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Name
Required. Enter the name of the environment variable you need to set for the task.

Example: Custom task "Start Service"

The following example shows how to define a task that can be used to start services on Windows machines.

The task is called Start Service. It uses the net binary that is located on the Windows machine.

Example - Add custom task

Two arguments must be passed to the net command:
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The option start which is defined as a constant value:

Example - Add argument 1

The Service name which must always be specified:

Example - Add argument 2

After pressing the Ok button in the Add custom task dialog, the new task is automatically selected:
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Example - Resulting custom task
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Editing custom tasks

After selecting  Tools Edit custom task ...  a dialog is opened where you can choose the task you want
to edit.

Edit custom 

After selecting the task and pressing the Ok button, the task is loaded into the Add custom task ... dialog
which is described above.
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Removing custom tasks

After selecting  Tools Remove custom task ...  a dialog is opened where you can choose the task you
want to remove.

Remove custom 

After selecting the task and pressing the Ok button, a dialog is displayed where you must confirm removal
of the selected task.

Confirm dialog for Remove-
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Administrative Tasks

View FileNet Listener Licences

Description

This task can analyze the output of the Listener concerning the licencing in many different ways:

• Return whether the licence requests or the count of people who requested a licence.

• Request the data with pre defined time parameters or give an individual time setting to the program.

• Return all received output or filter out the maximum value or only return the values which are greater
than a given threshold.

• Return detailed lists or disable details.

• Return as human readable list or in CSV format.
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Parameters

View FileNet Listener Licences

Servers (mandatory)
Select the server(s) where the task must be started.

Host (optional)
The hosts name or IP address. If no host is entered, the program will chose localhost as default.

NOTE This is NOT the server where this task will be executed on!
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This name or IP address will be used for the Listener request.

Port (optional)
The hosts port. If no port is given, the program will chose 32775.

Java path
Required. Specify the path to the Java bin directory.

ApplicationNames (optional)
This are the applications whose return data shall be requested. Several Application names can be
given as a semi colon separated list. No wildcards are allowed, the full name of the application
must be given. If no application name is given, every value from the output will be compared.

RequestType (mandatory)
There are two different values which can be requested by the monitor.

• LICENCE
Will request how many different users used a licence in a period of 15 minutes. The maxi-
mum of these values can be analyzed with the monitor.

• USAGE
Will request how many requests on licences have been made within 15 minutes.

Start Time (mandatory)
This parameter field can handle some pre defined time configuration options. The following options
are available.

• NOW - The values for the last 15 minutes are requested (No detailed output available here).

• TODAY - Request data from the actual day 00:00:00 till the actual time

• YESTERDAY - Request data from 00:00:00 until 23:59:59 the day before (This shall be
used as the most common option)

• THIS_WEEK_START_SUNDAY - Request data from Sunday 00:00:00 of the actual week
until the actual time.

• THIS_WEEK_START_MONDAY - Request data from Monday 00:00:00 of the actual week
until the actual time.

• LAST_WEEK_START_SUNDAY - Request data from Sunday 00:00:00 of the last week
until Saturday 23:59:59 of the last week.

• LAST_WEEK_START_MONDAY - Request data from Monday 00:00:00 of the last week
until Sunday 23:59:59 of the last week.

• THIS_MONTH - Request data from the first day 00:00:00 of the actual month till the actual
time

• LAST_MONTH - Request data from the first day 00:00:00 of the last month till the last day
23:59:59 of the last month.
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• THIS_FIRST_QUARTER - Request data from January 1st 00:00:00 till March 31st 23:59:59
of the actual year.

• THIS_SECOND_QUARTER - Request data from April 1st 00:00:00 till June 30th 23:59:59
of the actual year.

• THIS_THIRD_QUARTER - Request data from July 1st 00:00:00 till September 30th
23:59:59 of the actual year.

• THIS_FOURTH_QUARTER - Request data from October 1st 00:00:00 till December 31th
23:59:59 of the actual year.

• LAST_FIRST_QUARTER - Request data from January 1st 00:00:00 till March 31st
23:59:59 of the last year.

• LAST_SECOND_QUARTER - Request data from April 1st 00:00:00 till June 30th 23:59:59
of the last year.

• LAST_THIRD_QUARTER - Request data from July 1st 00:00:00 till September 30th
23:59:59 of the last year.

• LAST_FOURTH_QUARTER - Request data from October 1st 00:00:00 till December 31th
23:59:59 of the last year.

• THIS_FIRST_HALF - Request data from January 1st 00:00:00 till June 30th 23:59:59 of the
actual year.

• THIS_SECOND_HALF - Request data from July 1st 00:00:00 till December 31st 23:59:59
of the actual year.

• LAST_FIRST_HALF - Request data from January 1st 00:00:00 till June 30th 23:59:59 of the
last year.

• LAST_SECOND_HALF - Request data from July 1st 00:00:00 till December 31st 23:59:59
of the last year.

• THIS_YEAR - Request data from January 1st 00:00:00 till December 31st 23:59:59 of the
actual year.

• LAST_YEAR - Request data from January 1st 00:00:00 till December 31st 23:59:59 of the
last year.

It is also possible to define a start time with the format "yyyy-mm-dd hh:mm:ss". This defines the
start point.

Example: 2006-01-19 16:24:14

End Time (optional)
If End Time is defined in the format "yyyy-mm-dd hh:mm:ss" with this parameter a end time can
be defined in the same way. It is not necessary to define a end point. The program will take the
actual date as end time if none is defined here.

RunOption (mandatory)
The task can run in several different modes.

• ALL
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Return all the response from the Java program (the complete list)

• MAX
Only returns the maximum value. If two data sets have the same value, the actual data set
will not be overwritten by the new data set.

• THRESHOLD
All data sets which have a greater value than the threshold are returned.

Details (mandatory)
This parameter can turn the detail output ON and OFF. If it is turned OFF, only the headers of the
request will be returned. Otherwise the headers and the data sets will be printed out.

Output Mode (mandatory)
The output mode defines how the response shall be printed out in the task.

• STANDARD - Best readable for humans

• CSV - Best readable for machines
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View FileNet Listener Output

Description

This task starts a FileNet listener request.

Parameters
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Servers
Required. Select the server(s) where the task must be started.

Request on server
Optional. Specify the name of the server for the Listener request.

NOTE This is NOT the server where this task will be executed on.

This name or IP address will be used for the Listener request. Default value is localhost, but any
name or IP address can be specified here.

Request on port
Optional. Specify the name of the port for the Listener request.

This port will be used for the Listener request. Default value is 32775.

Java path
Required. Specify the path to the Java bin directory.

Listener Paths
Required. Specify any correct Listener path (see FileNet documentation for further details) or use
the predefined values.
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Appendix A. Copyright notice

IBM FileNet System Monitor (18 March 2011)

Copyright © 2000-2011 CENIT AG, Germany; Copyright © 2005, 2011 IBM Corp., USA including this doc-
umentation and all software.

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or trans-
lated into any computer language, in any form or by any means, electronic, mechanical, magnetic, optical,
chemical, manual, or otherwise, without prior written permission of the copyright owners. The copyright own-
ers grants you limited permission to make hardcopy or other reproductions of any machine-readable docu-
mentation for your own use, provided that each such reproduction shall carry the original copyright notice.
No other rights under copyright are granted without prior written permission of the copyright owners. The
document is not intended for production and is furnished as is without warranty of any kind. All warranties on
this document are hereby disclaimed including the warranties of merchantability and fitness for a particular
purpose.

Note to U.S. Government Users Documentation related to restricted rights Use, duplication or disclosure is
subject to restrictions set forth in GSA



Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

© Copyright IBM Corp. 2001, 2010



Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.
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www.ibm.com/legal/copytrade.shtml.
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